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Suitable SCE trainer packages to accompany these training curriculums 

 

LOGO! Controllers 

• LOGO! 8 12/24V ETHERNET – set of 6  

Order no.: 6ED1057-3SA20-0YA1 

• LOGO! 8 230V ETHERNET – set of 6 

Order no.: 6ED1057-3SA20-0YB1 

 

Note that these trainer packages will be replaced with successor packages when required. 

You can find an overview of the currently available SCE packages at: siemens.com/sce/tp 

 

 

Further education 
For further Siemens SCE education opportunities in your region, get in touch with your regional SCE 

contact siemens.com/sce/contact 

 

 

Further information on SCE  
siemens.com/sce 

 

Notes on use 
This SCE training curriculum for the integrated automation solution Totally Integrated Automation (TIA) 

was prepared for the program "Siemens Automation Cooperates with Education (SCE)" specifically for 

training purposes for public educational and R&D institutions. Siemens AG assumes no responsibility for 

the content. 

 

This curriculum may be used only for initial education with respect to Siemens products/systems. That is, 

it may be copied in part or in whole and handed out to trainees for use within the framework of their 

education. Transmission and reproduction of this curriculum as well as communication of its content is 

permitted within public educational institutions for educational purposes.  

 

Exceptions require written permission from the Siemens AG contact: Roland Scheuerer 

roland.scheuerer@siemens.com. 

 

Parties breaching this provision shall be liable for damages. All rights reserved, including those relating to 

translation and in particular those rights created as a result of a patent being granted or utility model 

being registered. 

Use for industry customers is expressly prohibited. Commercial use of the curriculum is not permitted. 

 

We would like to thank Michael Dziallas Engineering and all those involved for their support in creating 

this SCE training curriculum. 

http://www.siemens.com/tp
http://www.siemens.com/contact
http://www.siemens.com/contact
http://www.siemens.com/sce
file:///C:/Users/z001373m/AppData/Local/Temp/Temp1_LOGO!.zip/roland.scheuerer@siemens.com
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1 Objective 

The SCE_EN_900-011 module provides a quick introduction to the handling of LOGO! 0BA8 logic 

modules and programming with the LOGO!Soft Comfort V8.0 software. 

2 Requirement 

Nothing is required from other chapters to successfully complete this chapter. 

3 Theory 

3.1 Information about the use of LOGO! 0BA8 

LOGO! is the universal logic module of Siemens. 

The LOGO! logic module has an integrated controller with operator control and display unit. You 

can use the operator control and display unit of LOGO! to create and edit programs and execute 

system functions. 

You can read in external programs from a program module via the Ethernet interface or a PC 

cable with the LOGO!Soft Comfort programming software. You can use LOGO!Soft Comfort not 

only to create a program but also to simulate your circuit on the computer and to output overview 

diagrams to a printer. 

Depending on the device type, ready-made commonly-used basic functions, e.g. for delayed 

switch-on and switch-off, for current-impulse relay, time switch, and binary bit memory and for 

inputs and outputs, are already contained in the LOGO! logic modules. 

 

With LOGO! you solve tasks for 

– home automation and installation engineering (e.g. stairway lighting, outside lighting, 
awnings, roller shutters, show window lighting and much more)  

– manufacture of control cabinets, machines and equipment (e.g. gate controls, 
ventilation systems, industrial water pumps and much more) 

 

LOGO! can also be used for special-purpose control for signal pre-processing. 

When connected to AS-Interface, LOGO! can be used as distributed I/O with local intelligence for 

control of machines and processes. This enables the LOGO! logic module to perform control 

tasks and reduce the load on the master controller. 

 

For series applications in small machine and equipment manufacturing, control cabinet 

manufacturing, and installation engineering, special versions without operator control unit are 

available. A program module or the LOGO!Soft Comfort PC software is required for downloading 

to these modules. 
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3.2 Setting the IP address of the LOGO! 0BA8 

With the LOGO! 0BA8 in Stop mode, navigate to the Network menu command. You 

can find the settings for the IP address, subnet mask and gateway here.  

Use the ► cursor or OK to enter Edit mode of the network settings. Assign the 

network settings according to the information from your network administrator.  

 

Note:  

In the rows with the ► or ▼ symbol, you can also navigate using the cursor key.  

 

3.3 LOGO!Soft Comfort V8.0 

The software provides a completely new user interface with the following functions: 

 Consistent application menu display 

 New network project-based work strategy 

 Split display for diagram mode and network mode 

 Split display for "Standard" toolbar in the general software interface, "Tool" toolbar is 

displayed in diagram mode and "Network" toolbar in project mode. 

 Split window display with focus switching and drag-and-drop capability 

 Work on a network project enables saving, downloading, creating and closing of the network 

project. 

 New access control settings for online access with various access possibilities 

 Ability to create connections by configuring NI and NQ function blocks 

 New graphic reference for the function block in the parameter field in FBD diagrams  

 Ability to configure the screen display for messages, start screen and flags with 4 lines for 

LOGO! devices before 0BA8 and 6 lines for LOGO! devices starting from 0BA8 

 Enhanced system security by assignment of user passwords and access levels in the access 

control settings 

Start 

Program ► 

Setup ► 

Network ► 

Diagnostics ► 

Card ► 

IP – Address 

Set M / S Mode 

 

 

 

 

IP – Address 
192.168.000.001 ▼ 

Subnet Mask 
255.255.255.000 ▼ 

Gateway 
000.000.000.000 ▼ 

OK 

OK 
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3.3.1 Programming interface 

Programming mode in LOGO!Soft Comfort starts with an empty diagram. 

The majority of the screen is taken up by the user interface for creating the circuit diagram – in 

other words, the programming interface. The symbols and logic operations of the circuit program 

are arranged on this programming interface. 

To help you maintain an overview of more extensive circuit programs, scroll bars are provided 

below and to the right of the programming interface, which can be used to scroll horizontally and 

vertically in the control program. 

 

 

① Menu bar 

② "Standard" toolbar  

③  Mode bar 

④  "Tool" toolbar 

⑤  Programming interface  

⑥ Status bar  

⑦  Diagram tree  

⑧  Operation tree 
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3.3.2 Project interface 

The LOGO!Soft Comfort project interface displays a network view with the devices and network 

connections.  

After you select "Add New Device", the Diagram Editor window appears. 

Only LOGO! devices starting from 0BA7 can be programmed in a network project. 

The Diagram Editor displays the program blocks and logic operations of the circuit program. The 

circuit program is initially empty. 

To help you maintain an overview of more extensive circuit projects and programs, scroll bars are 

provided below and to the right of the network view and programming interface. They can be 

used to scroll horizontally and vertically in the control program. 

 

① Menu bar 

② "Standard" toolbar  

③  Mode bar 

④  "Network" toolbar 

⑤  Network view 

⑥ "Tool" toolbar 

⑦ Programming interface 

⑧ Status bar  

⑨ Diagram tree  

⑩ Operation tree 



SCE Training Curriculum | Additional Module 900-011, Edition 05/2016 | Digital Factory, DF FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2016. All rights reserved. 9   

SCE_EN_900-011_Startup_LOGO!_0BA8_R1603.docx    

4 Task: Factory gate control with LOGO! 0BA8 

It is often possible to access a company's premises at more than one location. At each access 

point, it must be ensured that the gate can be opened and closed using pushbuttons directly on the 

gate or pull cords from the vehicle. 

5 Planning 

A LOGO! OBA8 is used for the control. 

The gate is opened or closed using a cord-operated switch. The gate is fully opened or closed in 

this case. 

In addition, every gate can be opened and closed locally in jog mode using pushbuttons. 

A flashing light is activated 5 seconds before the gate movement starts and continues during the 

gate movement. 

A safety pressure strip ensures that no persons are injured and no objects are caught and 

damaged when the gate closes. 

 

 

Safety pressure strip 
Warning light 
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5.1 Technology schematic diagram 

Here you see the technology schematic diagram with the wiring for the task. 

 

 

Figure 1: Technology schematic diagram 

Open gate     Close gate   Warning light 
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5.2 Reference table 

The following signals are required for this task. 

DI ID Function NC/NO 

I1 -S0 OPEN GATE cord switch NO 

I2 -S1 CLOSE GATE cord switch NO 

I3 -S2 OPEN GATE pushbutton NO 

I4 -S3 CLOSE GATE pushbutton NO 

I5 -S4 GATE IS OPENED position switch NC 

I6 -S5 GATE IS CLOSED position switch NC 

I7 -S6 Safety pressure strip NC 

 

DO ID Function  

Q1 -K1 Contactor open gate  

Q1 -K2 Contactor close gate  

Q3 -H1 Warning light  

 

Legend for reference list 

 

DI Digital input DO Digital output 

I Input Q Output 

NC Normally Closed   

NO Normally Open   
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6 Structured step-by-step instructions 

You can find instructions on how to perform planning below. If you already have a good 

understanding of everything, it is sufficient to focus on the numbered steps. Otherwise, simply 

follow the steps of the instructions illustrated below. 

6.1 Starting LOGO!Soft Comfort V8.0 and adding LOGO! 0BA8 

 Start the LOGO!Soft Comfort V8.0 software. 

 

 The LOGO!Soft Comfort software opens in diagram mode. 
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 Click the Network project tab. 

 

 Click on "Add New Device" in the Network view. 

 In the device selection window, select LOGO! 0BA8. 

 Enter the network settings under Configuration. 

 Confirm your selection with OK. 
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6.2 LOGO! 0BA8 settings 

 Open the LOGO! settings by double-clicking on Settings. 

 

 All offline/online settings of LOGO! 0BA8 can be edited here. 
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 I/O settings for the configuration of the analog terminals. 

 

 I/O names for designating the input and output terminals. 

 

 Close the LOGO! settings window with OK. 
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6.3 Entering input/output names 

 You can also open the I/O names window via the Edit menu. 

  

 Enter the I/O names of the factory gate control and close the window with OK. 
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6.4 Entering a program in the Diagram Editor 

6.4.1 Inserting blocks 

 Minimize the network view. Right-click the name of the diagram and select "Rename". 

Then change the name to gate_control. 

 

 Using drag-and-drop, move 7 inputs to the programming interface and place them in 

the following order from top to bottom: I1, I3, I5, I2, I4, I6 and I7. 
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6.4.2 Aligning blocks 

 Select the inserted inputs using Ctrl+click. 

 Click the Align vertically button. 
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 Click the Space vertically button and enter 50 for the distance value. 

 Confirm with OK. 
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 Move the Q1, Q2 and Q3 outputs to the programming interface using drag-and-drop. 

 Select the inserted outputs using Ctrl+click.  

 Click the Align vertically button. 

 Click the Space vertically button. 

 Enter 200 for the distance value.  

 Confirm with OK. 
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6.4.3 Setting parameters 

 Using drag-and-drop, place an On-delay in front of output Q1. 

 Double-click on B001 (On-delay) and set the time to 5 seconds. 
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 The block functions in the programming interface can be shown using buttons. 

 

 

 Place the remaining blocks B002 to B016 and set the times for B007 and B016. 
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6.4.4 Connecting blocks 

 To complete the circuit, the individual blocks still have to be connected to one another. 

For this purpose, select the  button for the block connection in the Tool toolbar. 

 

6.4.5 Saving the finished circuit diagram of the gate control as a network 

project 

 To save, click the diskette button  and enter gate_control for the file name. 
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6.5 Simulation of the circuit 

Program simulation allows you to test a circuit program and change its parameter assignment. 

In this way you can ensure that you transfer a functional and optimized circuit program to your 

LOGO! 

 The input signals should be preset for the simulation. Double-click on input I1. 

 Go to the Simulation tab and select Momentary pushbutton (make). 

 Also set inputs I2, I3 and I4 to Momentary pushbutton (make) under Simulation. 

 

  

 Double-click on input I5. 

 Go the Simulation tab and select the Momentary pushbutton (break). 

 Also set inputs I6 and I7 to Momentary pushbutton (break) under Simulation. 

 

 

 Save your circuit diagram. 



SCE Training Curriculum | Additional Module 900-011, Edition 05/2016 | Digital Factory, DF FA 

For unrestricted use in educational / R&D institutions. © Siemens AG 2016. All rights reserved. 25   

SCE_EN_900-011_Startup_LOGO!_0BA8_R1603.docx    

 To start the simulation, click the simulation button  in the Tool toolbar. You are 

then in simulation mode. 
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6.6 Transferring the tested program to LOGO! 

 Once you have tested your program with LOGO!Soft Comfort simulation, you can 

transfer it from PC -> LOGO! with the  button.  

 Click the Refresh button  to display the accessible LOGO! devices. 

 

 Confirm the next window with OK or Yes. 
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6.7 Online test 

 With the online test button , the circuit program can be tested in connection with the 

LOGO!. The states of the inputs and outputs and logic operations are displayed.  

 Click the Online test button  to start monitoring. 
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6.8 Checklist 

No. Description Completed 

1 Project created  

2 LOGO! controller detected and entered in the project  

3 Successful download of the program to the LOGO! without error message  

4 Actuate open gate cord switch (I1 = 1), warning light flashes  Q3 = 0-1-0-1  

5 After 5 s, the gate opens (I6 = 1) Q1 = 1   

6 Gate is opened (I5 = 0)  Q1 = 0, Q3 = 0  

7 Actuate close gate cord switch (I2 = 1), warning light flashes  Q3 = 0-1-0-1  

8 After 5 s, the gate closes (I5 = 1) Q2 = 1  

9 Gate is closed (I6 = 0)  Q2 = 0, Q3 = 0  

10 Actuate open gate pushbutton (I3 = 1), warning light flashes  Q3 = 0-1-0-1  

11 After 5 s, the gate opens (I6 = 1) Q1 = 1  

12 Release open gate pushbutton (I3 = 0)  Q1 = 0, Q3 = 0  

13 Actuate pushbutton close gate (I4 = 1), warning light flashes  Q3 = 0-1-0-1  

14 After 5 s, the gate closes (I5 = 1) Q2 = 1  

15 Release close gate pushbutton (I4 = 0)  Q2 = 0, Q3 = 0  

16 Actuate close gate cord switch (I2 = 1), warning light flashes  Q3 = 0-1-0-1  

17 After 5 s, the gate closes (I5 = 1) Q2 = 1  

18 Actuate safety strip (I7 = 0)  

19 Gate stops  Q2 = 0, Q3 = 0  

20 Actuate pushbutton close gate (I4 = 1), warning light flashes  Q3 = 0-1-0-1  

21 After 5 s, the gate closes (I5 = 1) Q2 = 1  

22 Actuate safety strip (I7 = 0)  

23 Gate stops  Q2 = 0, Q3 = 0  
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7 Task: Message text 

7.1 Task 

In this task, you expand the gate control program to include a message text function. The 

expanded diagram is to be planned, programmed and tested. In addition, the status of the 

gate will be displayed on the LOGO! display. In order for the message text to also be 

displayed via a Web browser, the Web browser is selected as an additional message 

destination. 

7.2 Insert message texts 

You can use drag-and-drop to move message texts under Miscellaneous to the diagram and 
interconnect them. 

 Move two message texts to the programming interface. 

 Interconnect the message texts with input I6 (gate is closed NC) 

 Negate the interconnection at block B017. 

 

Note: 

The message text in the block:  

 B017 is displayed when the gate is closed. 

 In contrast, B018 appears when the gate is open. 
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7.3 Enter message text 

 Double-click on message text block B017. The window for parameter assignment of 

the message text opens. 

Each message text has a priority. If multiple message texts are pending, the text with the 

higher priority is always displayed. 

 Select LOGO! display and Web server as message destinations. 

 Enter gate closed as the message text. 

 Click OK to close the window. 
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 Double-click on message text block B018. The window for parameter assignment of 

the message text opens. 

 Select LOGO! display and Web server as message destinations. 

 Enter gate open as the message text. 

 Click OK to close the window. 

 

Note:  

Information on further use of message texts can be found in the online help. 
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7.4 Assign backlighting of the message text 

Backlighting on the LOGO! display can be specified using flags. 

 

 Set flag 25 for white backlighting after the message text (B017) and flag 28 for yellow 

backlighting after the message text (B018). 

 

 

Note: 

The output of the message text block must be interconnected. Alternatively, you can also 
interconnect an open terminal here. 
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7.5 Simulation of the message texts 

 To start the simulation, click the simulation  icon in the Tool toolbar. You are then 

in simulation mode. 
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7.6 Online test of the message texts 

You can use the Adjust message text button  to show the message text of the  

LOGO! display in the view. 
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7.7 "Message text" checklist 

No. Description Complet

ed 

1 Project created  

2 LOGO! controller detected and entered in the project  

3 Successful download of the program to the LOGO! without error message  

4 Message text on LOGO! display "Gate closed" with white background  

5 Actuate open gate cord switch (I1 = 1), warning light flashes  Q3 = 0-1-0-1  

6 After 5 s, the gate opens (I6 = 1) Q1 = 1   

7 Message text on LOGO! display "Gate open" with yellow background  

8 Gate is opened (I5 = 0)  Q1 = 0, Q3 = 0  

9 Actuate close gate cord switch (I2 = 1), warning light flashes  Q3 = 0-1-0-1  

10 After 5 s, the gate closes (I5 = 1) Q2 = 1  

11 Gate is closed (I6 = 0)  Q2 = 0, Q3 = 0  

12 Message text on LOGO! display "Gate closed" with white background  

13 Actuate open gate pushbutton (I3 = 1), warning light flashes  Q3 = 0-1-0-1  

14 After 5 s, the gate opens (I6 = 1) Q1 = 1  

15 Message text on LOGO! display "Gate open" with yellow background  

16 Release open gate pushbutton (I3 = 0)  Q1 = 0, Q3 = 0  

17 Actuate pushbutton close gate (I4 = 1), warning light flashes  Q3 = 0-1-0-1  

18 After 5 s, the gate closes (I5 = 1) Q2 = 1  

19 Release close gate pushbutton (I4 = 0)  Q2 = 0, Q3 = 0  

20 Actuate close gate cord switch (I2 = 1), warning light flashes  Q3 = 0-1-0-1  

21 After 5 s, the gate closes (I5 = 1) Q2 = 1  

22 Actuate safety strip (I7 = 0)  

23 Gate stops  Q2 = 0, Q3 = 0  

24 Actuate pushbutton close gate (I4 = 1), warning light flashes  Q3 = 0-1-0-1  

25 After 5 s, the gate closes (I5 = 1) Q2 = 1  

26 Actuate safety strip (I7 = 0)  

27 Gate stops  Q2 = 0, Q3 = 0  
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8 Displaying message texts via a Web browser 

8.1 Activating the Web server in LOGO! 

To display message texts of the LOGO! via a Web browser, the Web server must first be 

activated in the online settings of LOGO!. 

 Double-click on Settings in the network project. 

 Select the Online Settings tab in the LOGO! settings window. 

 

 Click Connect to activate the online settings of LOGO!. 
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 Click on Access control settings. 

 Confirm the change to STOP mode. 

 

 Select the Allow Web server access check box and click Apply. 
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The Web server is activated and the LOGO! changes back to RUN mode. 

 Confirm the change to RUN mode. 

 

 Click OK to close the LOGO! settings window. 
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8.2 LOGO! in the Web browser 

 Start Internet Explorer and enter the IP address of the LOGO!. 

 

 Set the language to English and click "Log on". 
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 Click on LOGO! BM to show the LOGO! display in the Web browser. 

 

 

 

 

Note:  

Information on further use of the Web view can be found in the online help. 
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9 Additional information 

 

In the "Instructions" folder of this training curriculum 900-011, you can find additional information on 

programming and handling of LOGO!, such as online help, LOGO! product manual and LOGO! 

presentations. See link below. 

You can also find a helpful collection of links such as: LOGO! Web Based Training, Getting 

Started, Videos, Tutorials, Apps, Manuals, Programming Guidelines and Trial Software/Firmware, 

at the following link : 

 

www.siemens.com/sce/logo 

 

http://www.siemens.com/sce/logo
http://www.siemens.com/sce/logo

